
Exercício 3 – Associação de dados externos a camadas do banco de dados 

A Figura 1 exibe um Modelo Conceitual, do domínio do problema deste exercício, segundo a 

notação da Modelagem de Objetos e Relacionamentos – MOR de Embley (1998). Nele, os 

distritos do MSP estão associados a um número de variáveis socioeconômicas com seus 

valores, indicadas de forma genérica, e não explícita, uma a uma. Também a um certo número 

de homicídios. Os dados socioeconômicos e de homicídios estão associados ao ano de sua 

ocorrência/levantamento. Os distritos também estão associados a hospitais e estes, a dados, 

como, por exemplo, o número de leitos. 

Figura 1 – Modelo Conceitual MOR do Domínio do Exercício 3 

 

Observar que este diagrama, ao contrário dos demais vistos nos exercícios anteriores, não 

indica operações a serem executadas (o ‘como’), mas a estrutura de dados a ser criada 

(‘o que’), parte deste exercício. Ele representa uma estrutura conceitual, idealizada, do 

domínio do problema, mas não necessariamente toda a informação que se pode obter dos 

arquivos de dados, a serem coletados na Parte I deste exercício, a seguir. 
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Parte I – coleta de dados e criação do ambiente de trabalho 

(1) 

Baixar e descompactar os arquivos abaixo, em uma pasta de trabalho, por exemplo, 

Exercicio 3: 

 • homicides2002.csv – ocorrências de homicídos no Município de São Paulo em 2002 

 • SOC_ECONOMY. csv – dados sócio-econômicos dos distritos do Município de São Paulo 

 • HOSPITALS. csv – hospitais nos distritos do Município de São Paulo – em formato CSV 

Nota importante: os dados acima foram obtidos do tutorial da versão 4.2.2 (já obsoleta) do 

software SIG TerraView do sítio eletrônico do INPE – Instituto Nacional de Pesquisas Espaciais, 

há bastante tempo. Há de se ressaltar que se trata de dados fictícios, sem metadados (data, 

origem, forma de coleta, descrição, etc.), e dessa forma, não podem ser usados em aplicações 

reais. 

(2) 

Criar novo projeto no QGIS, por exemplo, AUT5826 – Exercicio 3, conectar ao GeoPackage dos 

exercícios anteriores para incluir a camada no projeto. 

 Project > New 

 Project > Save  AUT5826 – Exercicio 3 

 Database > DB Manager 

  New Connection… 

   navegar e selecionar Exercicio_1.gpkg 

   GeoPackage 

    Exercicio_1.gpkg 

     DistritosCEM 

     Add to Canvas 

Fechar a janela e salvar o projeto. 

(3) 

Separar os distritos do município de São Paulo, dos demais municípios e salvar como nova 

camada, DistritosCEM-MSP, num novo GeoPackage, por exemplo, Exercicio_3.gpkg. 

Remover a camada original DistritosCEM dista do novo projeto, deixando apenas a nova, e 

salvar o projeto, para refletir essas atualizações. 

Parte II – Incorporação de dados de ocorrências de homicídio em 2002 

Antes de tentar referenciar os dados no QGIS, há de se tentar saber do seu conteúdo. O 

arquivo formato CSV é do tipo texto e, portanto, pode ser lido, por exemplo, com Notepad 

(Bloco de Notas), ou WordPad. 

(4) 

Observe que os dados estão organizados em colunas, separadas por ponto e vírgula ( ; ). A 

primeira linha indica os nomes dessas colunas: ID, LOC_X e LOC_Y. 



A coluna ID identifica cada ocorrência e deve ter sido gerada automaticamente quando da 

entrada de dados de ocorrências de homicídios. Se houvessem outras tabelas com 

informações mais detalhadas sobre cada homicídio essa seria a coluna de ligação com elas. 

Observe que as coordenadas, dadas por LOC_X e LOC_Y, em projeção UTM, têm suas partes 

fracionárias separadas da inteira por um ponto ( . ) e não por uma vírgula ( , ). 

(5) 

Layer > Add Layer > Add Delimited text layer... 

 File name: clique no botão [...] e selecione homicides2002.csv 

 Layer name: deve ter sido preenchido automaticamente como homicides2002 

 Encoding: UTF-8 (neste caso, não importa, por não haver texto com acentuação) 

 File Format 

  ( • ) Custom delimiters: [ √ ] Semicolon 

 Record and Fields Options 

  Number of header lines to discard: 0 (primeira linha é de fato dos nomes dos 

atributos) 

  [ √ ] First Record has Field names – 1ª linha são os nomes dos campos 

  [ √ ] Detect field types – para associar os tipos de dados a partir dos dados 

  [   ] Decimal separator is comma – o separador é na verdade o ponto ( . ) 

  [   ] Trim fields – caso houvesse texto com espaço(s) em branco antes ou 

depois dele 

  [   ] Discard empty fields 

 Geometry Definition 

  ( • ) Point coordinates – pelas colunas LOC_X e LOC_Y definirem coordenadas 

   X field: LOC_X 

   Y field: LOC_Y 

   [   ] DMS coordinates – coordenadas estão em metros, não em graus 

   Geometry CRS: EPSG: 5533 – SAD69(96) / UTM zone 23S 

 Layer Settings 

  LOC_X e LOC_Y devem estar como Decimal (Double), ou seja, número em 

ponto flutuante com dupla precisão 

 [ Add ] – para executar, depois [ Close ] 

 Observar que os pontos, de coordenadas, representativos dos registros de homicídio, 

estejam coerentes com o mapa dos distritos de São Paulo. 

(6) 

Carregar os dados no GeoPackage enquanto se altera o sistema de coordenadas para o 

SIRGAS2000, mantendo-se a projeção UTM 23S. Em seguida, remover a referência antiga, da 

lista de camadas do projeto, e salvar. 

(7) 

Contagem de homicídios em cada distrito do MSP em 2002. 

Aplicar a contagem visual seria não tirar proveito dos recursos contemporâneos 

disponibilizados pelo software SIG. Além de tedioso está sujeito a erros e omissões. 



Vector > Analysis Tools > Count Points in Polygon... 

 Polygons: DistritosCEM-MSP [EPSG:31983] 

 Points: homicides2002 [EPSG:31983] 

 Weigt field [optional]: permite somar os valores de alguma coluna, ao invés da simples 

contagem – não é o caso (não pode ser usado em conjunto com Class Field) 

 Class Field [optional]: permite usar uma das colunas como qualificador, caso em que 

apenas se registra haver ou não haver pontos para cada valor dessa coluna (não pode ser 

usado em conjunto com Weight Field) – também não é o caso 

 Count field name: ocorrências 

 Count: clique no botão [...] selecione: Save To File e indique o nome da nova camada, 

no GeoPackage, com a contagem, por exemplo, Distritos-homicidios 

 [v] Open output file after running algorithm 

[ Run ] e [ Close ] 

Observar na lista, a nova camada, e visualizar o valor do atributo ‘ocorrencias’ de cada distrito. 

(8) 

Alterar a simbologia de cor para comparação dos distritos quanto às ocorrências. 

 distritos-homicidios > Properties > Symbology 

 Alterar de ‘Single Symbol’ para ‘Graduated’ 

 Value: ocorrências 

 Precision: 0 (sem casas decimais em cada categoria) 

 Color ramp: Reds (sugestão) 

 Classes: empiricamente, raiz quadrada do número de distritos, ou seja, 9 ou 10 

 Mode: observar para cada opção de arranjo a escala de valores: 

  Equal Count (Quantile) – mesma frequência em cada faixa da classificação 

  Equal Interval – intervalos iguais da menor para a maior faixa 

  Natural Breaks (Jenks) – minimizar as variâncias das faixas, cada qual em 

relação às suas médias 

  e escolher a que julgar mais apropriada para apresentar a questão. 

[ Apply ] e [ OK ] 

(9) 

Ajuste a ordem das camadas da lista, de modo que os pontos, representativos das ocorrências 

sejam exibidos sobre os polígonos da camada distritos-homicidios. 

O mapa temático produzido não discrimina o local de registro das ocorrências. Há 

instrumentos, da geo-estatística, não tratados aqui, que podem descrever com maior precisão 

o fenômeno em termos de sua geografia. 

(10) 

Antes de prosseguir ocultar as camadas da lista, exceto a distritos-homicidios, e salve o 

projeto. 



Parte II – Associação de cada distrito com tabela de dados socioeconômicos 

Da mesma forma como feito na parte anterior deste exercício, antes de tentar carregar os 

dados no QGIS, há de se tentar saber do seu conteúdo. O arquivo formato CSV é do tipo texto 

e, portanto, pode ser lido, por exemplo, com Notepad (Bloco de Notas), WordPad. 

(11) 

Referenciar a tabela no QGis 

Layer > Add Layer > Add Delimited text layer... 

 File name: clique no botão [...] e selecione SOC_ECONOMY.csv 

 Layer name: deve ter sido preenchido automaticamente como SOC_ECONOMY 

 Encoding: UTF-8 (mas o único campo com texto é o DENO e não está acentuado) 

 File Format 

  ( • ) Custom delimiters: [ √ ] Semicolon 

 Record and Fields Options 

  Number of header lines to discard: 0 

  [ √ ] First Record has Field names – 1ª linha são os nomes dos campos 

  [ √ ] Detect field types – para associar os tipos de dados a partir dos dados 

  [   ] Decimal separator is comma – o separador é na verdade o ponto ( . ) 

  [   ] Trim Fields 

   caso houvesse texto com espaço(s) em branco antes ou depois dele 

  [   ] Discard empty fields 

 Geometry Definition 

  ( • ) No geometry (attribute only table) – por não conter coordenadas, as 

associações entre os dados sócio-econômicos com os distritos será feita com base nos valores 

das colunas NOMECAPS (da camada DistritosCEM-MSP) e DENO (da tabela a carregar) 

 Layer Settings 

  alterar o tipo de dados da coluna COD_IBGE, de Integer para Text (string)* 

 [ Add ] – para executar, depois [ Close ] 

 * Trata-se de atributo que não é passível de cálculos matemáticos e, ademais, deve ser 

concatenado com o código do município de São Paulo para ter utilidade prática. 

A tabela SOC_ECONOMY é exibida lista de camadas do projeto, mas não no mapa, por não 

estar neste momento associada a qualquer dado espacial. 

Pode-se visualizar seu conteúdo com Open Attribute Table 

(12) 

Carregar a tabela no GeoPackage, aproveitando para eliminar atributos desnecessários 

  SOC_ECONOMY > Export 

  Layer name: soc-economy – em minúsculas fica mais agradável 



  Select fields to export and their export options, desmarcando os atributos 

abaixo indicados: 

   [  ] ID – não tem significado no atual contexto 

   [  ] COD – idem 

   ... 

   [  ] DIST – idem 

  Geometry 

   Geometry type: No Geometry 

[v] Add saved file to map 

[ OK ] e [ Close ] 

(13) 

Remover a referência à tabela SOC_ECONOMY (inicialmente referenciada) e salvar o projeto. 

(14) 

Concatenar o código IBGE do município de São Paulo (‘3550308’), à frente dos códigos de dois 

dígitos, da coluna COD_IBGE, dos distritos. 

  soc_economy > Open Attribute Table 

  [Toggle Editing Mode ] 

  [ Open Field Calculator] 

   [v] update existing field 

    COD_IBGE 

  Na Caixa de texto Expression montar a seguinte expressão**: 

   if( ( length("COD_IBGE") = 1 ), concat( '35503080', "COD_IBGE" ), 

concat( '3550308', "COD_IBGE" ) ) 

  e verificar, ao final, em Preview se os resultados são os esperados 

 [ OK ] 

 Verificar o resultado na coluna COD_IBGE 

 [ Save Edits ] 

  [ Toggle Editing Mode ] 

 ** As funções acima indicadas são: 

  if( <condição a testar>, <ação se verdadeiro>, <ação se falso> )  Conditionals 

  length(< Text (string )>  String 

  concat( <Text (string) , <Text (string) )  String 

  “COD_IBGE” selecionado em  Fields and Values 

  e demais elementos digitados manualmente. 



(15) 

Ligar a tabela soc_economy ao mapa de distritos, da forma tradicional no QGis. 

 distritos-homicidios > Properties > Joins 

 [ + ] (Add New Join) para definir a ligação 

 Join layer: soc_economy 

 Join Field: COD_IBGE (mas poderia ser também DENO) 

 Target field: IBGECOD (mas poderia ser também NOMECAPS) 

 [ √ ] Cache join layer in virtual memory 

 [   ] Dynamic form – apenas se estiver editando dados e quiser que uma alteração no 

valor do campo IBGECOD de um distrito se reflita automaticamente no correspondente valor 

do campo COD_IBGE da tabela soc_economy a ele ligado 

 [   ] Editable join layer – apenas se deve marcar se for alterar valores dos campos da 

tabela resultado da ligação entre a que acompanha a camada distritos-homicidios e a tabela 

soc_economy a ele ligado 

 [√ ] Joined Fields – marcar para selecionar os campos a serem mostrados, da tabela 

soc_economy, como associados aos distritos correspondentes, por exemplo: RENDA_FAM, 

ANOS_EST, IDADE_MED e TAXA_CRESC 

  marque todas, exceto ID, DENO e COD_IBGE, por serem redundantes. 

 [√ ] Custom Field Name Prefix 

  marcar e alterar o default ‘soc_economy_’ para apenas SE_ 

[ OK ] 

Deve aparecer a ligação recém criada como Join layer soc_economy na lista, a qual pode ser 

Editada ou Removida quando desejado (veja botões Edit Selected Join e Remove Selected Join 

[ - ]. 

Importante: usar os botões [ Apply ] e [ OK ] antes de fechar a janela Properties > Joins, caso 

contrário o que foi definido, conforme acima indicado, nãos será executado. 

(15.1) 

 distritos-homicidios > Open Attribute Table 

 pode-se visualizar dados da tabela soc_economy associados a cada distrito, para cada 

um dos 96 distritos. 

Salve o projeto para atualizar seus mapas e joins. 

O Join está definido no projeto, e não no banco de dados. Trata-se de uma tabela dinâmica, 

cuja vantagem é de se manter atualizada, se forem feitas alterações nas features envolvidas, 

distrito-homicidios ou soc_economy. Mas, não será este o caso. 

Nota: o banco de dados SQlite permite criar tabelas dinâmicas, designadas por Views, porém, 

não há indicação deste recurso estar disponível no GeoPackage. 

(16) 

Criação de nova camada, no GeoPackage, que agregue os dados de distritos-homicidios e 

soc_economy numa única tabela a ela associada. 



(16.1) 

Mas, antes, há de se desfazer o Join, anteriormente definido. 

 distritos-homicidios > Properties > Joins 

  Join layer soc_economy – selecionar o join a ser desfeito 

 [  ̶  ] (Remove Selected Join) para desfazer a ligação 

 [Apply] e [OK] 

(16.2) 

Database > DBManager > GeoPackage 

  GeoPackage > New Connection… 

  navegue até a pasta de trabalho e selecione Exercicio_3.gpkg 

  Exercicio_3.gpkg – para efetivamente se conectar ao banco de dados 

Database > SQL Window 

 clicar no botão [SQL] - para abrir o SQL Query Builder (auxílio na elaboração de 

queries) 

  [Tables]  – para indicar as camadas/tabelas participantes 

    distritos-homicidios 

    social-economy 

  A caixa de texto Tables passa a exibir 

   “distritos-homicidios”, “socio-economy” 

  Clicar dentro da caixa de texto Where – para criar o predicado de junção (Join) 

  [Columns]  

   “distritos-homicidios”.”IBGECOD” 

    o qual é copiado para a caixa de texto Where 

  digite = após “distritos-homicidios”.”IBGECOD” e 

   mantenha o cursor após este caracter 

  [Columns]  

   “social-economy”.”COD_IBGE” 

    o qual deve ser copiado para a caixa de texto Where, 

    após o sinal de = 
  A caixa de texto Where deve exibir o predicado de junção 

   “distritos-homicidios”.”IBGECOD” = “social-economy”.”COD_IBGE” 



  Clicar dentro da caixa de texto Columns 

   para selecionar os atributos da nova camada 

  [Columns]  

   "distritos-homicidios"."geom" 

   "distritos-homicidios"."IBGECOD" 

   "distritos-homicidios"."SIGLA" 

   "distritos-homicidios"."NOME" 

   "distritos-homicidios"."NOMECAPS" 

   "distritos-homicidios"."com_metro" 

   "distritos-homicidios"."com_trem" 

   "distritos-homicidios"."ocorrencias" 

   "soc_economy"."RENDA_FAM" 

   "soc_economy"."QUOTA_RES" 

   "soc_economy"."ANOS_EST" 

   "soc_economy"."IDADE_MED" 

   "soc_economy"."MORT_INF" 

   "soc_economy"."TAXA_CRESC" 

   "soc_economy"."MORT_CEXT" 

   "soc_economy"."POP_FAV" 

   "soc_economy"."DENSID_POP" 

A lista de atributos, que inclui, obrigatoriamente a geometria dos distritos, também exclui os 

que podem ser considerados redundantes. 

A caixa de texto Fields passa a exibir o que segue. 

"distritos-homicidios"."geom", 

"distritos-homicidios"."IBGECOD", 

"distritos-homicidios"."SIGLA", 

"distritos-homicidios"."NOME", 

"distritos-homicidios"."NOMECAPS", 

"distritos-homicidios"."com_metro", 

"distritos-homicidios"."com_trem", 

"distritos-homicidios"."ocorrencias", 

"soc_economy"."RENDA_FAM", 

"soc_economy"."QUOTA_RES", 

"soc_economy"."ANOS_EST", 

"soc_economy"."IDADE_MED", 

"soc_economy"."MORT_INF", 

"soc_economy"."TAXA_CRESC", 

"soc_economy"."MORT_CEXT", 

"soc_economy"."POP_FAV", 

"soc_economy"."DENSID_POP" 

O resultado pode ser ordenado, por qualquer dos campos alfanuméricos, e se sugere usar 

IBGE, NOME ou NOMECAPS, o que preferir. 

 Clicar na caixa de texto ORDER BY e depois selecionar da lista Fields o desejado. 

[ OK ] 



A caixa de texto da Query na tela do DB Manager deve exibir a query, montada com o auxílio 

do SQL Query Builder. 

SELECT "distritos-homicidios"."geom", 

"distritos-homicidios"."IBGECOD", 

"distritos-homicidios"."SIGLA", 

"distritos-homicidios"."NOME", 

"distritos-homicidios"."NOMECAPS", 

"distritos-homicidios"."com_metro", 

"distritos-homicidios"."com_trem", 

"distritos-homicidios"."ocorrencias", 

"soc_economy"."RENDA_FAM", 

"soc_economy"."QUOTA_RES", 

"soc_economy"."ANOS_EST", 

"soc_economy"."IDADE_MED", 

"soc_economy"."MORT_INF", 

"soc_economy"."TAXA_CRESC", 

"soc_economy"."MORT_CEXT", 

"soc_economy"."POP_FAV", 

"soc_economy"."DENSID_POP" 

FROM "distritos-homicidios", "soc_economy" 

WHERE "distritos-homicidios"."IBGECOD" = "soc_economy"."COD_IBGE" 

ORDER BY "distritos-homicidios"."NOMECAPS" 

(16.3) 

Salvar a expressão e executar 

 [ SAVE AS FILE] – para guardar o texto da query em um arquivo, na pasta de trabalho, 

para eventual futuro uso e/ou documentação 

  q_distritos-homicidios-soc_economy 

 O arquivo q_distritos-homicidios-soc_economy.sql pode ser visualizado com editor de 

textos simples 

[Execute] para testar – os resultados, se executada corretamente, devem ser exibidos logo 

abaixo 

(16.4) 

Gerar a nova camada 

[v] Load as new layer – para criar a camada 

 [v] Column with unique values: IBGECOD 

 Geometry column: geom 

 Layer name (prefix): distritos-soc_economy 

 

[ Load ] 

(16.5) 

Carregar os dados no GeoPackage com o mesmo nome 

Após o qual, verificar se a operação foi bem sucedida, remover o layer virtual, e salvar o 

projeto 



Parte III – Associação dos distritos com hospitais, e contagem de leitos, médicos, 

enfermeiras, etc. 

(17) 

Carregar a tabela Hospitals diretamente no GeoPackage 

(17.1) 

Os tipos de dados de leitos, médicos, enfermeiro(a)s, ambulâncias, etc. podem ser 

interpretados genericamente pelo QGis como sendo do tipo caracteres (string), por isso, pode-

se criar um arquivo texto auxiliar, de mesmo nome do CSV, mas com terminação CSVT, antes 

de sua inserção no BD GeoPackage. 

O conteúdo desse arquivo CSVT, corresponde ao cabeçalho do arquivo CSV, ou seja, para: 

 HOSPITAL;DISTRITO;NUM_LEITOS;NUM_ENFERM;NUM_MEDICO;NUM_AMBULA; 

 PUBLICO;NUM_P_MASC,NUM_P_FEM;TOTAL_PAC;COL_TESTE 

Tem-se: 

 String,String,Integer,Integer,Integer,Integer,String,Integer,Integer,Integer,Integer 

(17.2) 

Database > DB Manager > GeoPackage > Exercicio_3  - para se connectar ao BD 

 [ Import Layer/File... ] 

  Input: HOSPITALS.csv 

 Output table 

  Table: Hospitals 

  Options 

   Primary key: HOSPITAL 

   Encoding: UTF-8 (default) – não há acentuação nos dados 

[ OK ] 

Observar na caixa de diálogo DB Manager que a tabela foi acrescida ao GeoPackage – em 

seguida fechar essa caixa e retornar à tela principal do QGis. 

(17.3) 

 Hospitals > Add to Canvas – para incluir a tabela no projeto 

Salvar o projeto. 

(17.4) 

Eliminar as colunas TOTAL_PAC, COL_TESTE, NUM_P_MASC e NUM_P_FEM, por não serem 

relevantes. 

Observar na tabela de hospitais que podem haver nenhum, um ou mais de um hospital em 

cada distrito. Trata-se de associação entre distritos e hospitais, dita de um para muitos (na 

realidade, de um para nenhum até muitos), representada, em muitos casos, como 1 : [0 .. N], 

ou similar. 

A simples junção da tabela de hospitais com os distritos iria gerar enorme redundância de 

dados. Ademais, interessa para tal junção, do ponto de vista de cada distrito, agregar os dados 

de número de hospitais, públicos ou privados, e, cada caso, o número total de leitos, médicos, 

ambulâncias, etc. 



(18) 

Agregar os dados dos Hospitais Privados por distrito. 

Database > DB Manager > GeoPackage > Exercicio_3.gpkg  

Database > SQL Window 

[ SQL ] 

Na caixa de diálogo SQL Query Builder 

 [ Tables ]  

  Hospitals 

 [ Columns ]  

  "Hospitals"."DISTRITO" 

  "Hospitals"."NUM_LEITOS" 

  "Hospitals"."NUM_ENFERM" 

  "Hospitals"."NUM_MEDICO" 

  "Hospitals"."NUM_AMBULA" 

Copiar manualmente a primeira linha dessa lista para as caixas de texto campo 

 Group By e Order By. 

 Alterar, manualmente, o conteúdo do campo Columns de modo a somar e dar nomes 

aos dados consolidados pela agregação, conforme indicado abaixo 

"Hospitals"."DISTRITO", 

Count(*) as Priv_Unidades, 

sum("Hospitals"."NUM_LEITOS") as Priv_Leitos, 

sum("Hospitals"."NUM_ENFERM") as Priv_Enferms, 

sum("Hospitals"."NUM_MEDICO") as Priv_Medicos, 

sum("Hospitals"."NUM_AMBULA") as Priv_Ambulas 

No campo Where, preencher com 

  “Hospitals”.”PUBLICO” = ‘N’ 

O valor ‘N’ é extraído das opções de valores para a coluna “Hospitals”.”PUBLICO” na aba 

Columns’ values 

[ OK ] 

De volta à caixa de diálogo DB Manager, salvar a query como q_agrega_hospitais_privados em 

sua pasta de trabalho. 



SELECT Count(*) as Priv_Unidades, 

"Hospitals"."DISTRITO"), 

sum("Hospitals"."NUM_LEITOS") as Priv_Leitos, 

sum("Hospitals"."NUM_ENFERM") as Priv_Enferms, 

sum("Hospitals"."NUM_MEDICO") as Priv_Medicos, 

sum("Hospitals"."NUM_AMBULA") as Priv_Ambulas 

FROM "Hospitals" 

WHERE "Hospitals"."PUBLICO" = 'N' 

GROUP BY "Hospitals"."DISTRITO" 

ORDER BY "Hospitals"."DISTRITO" 

Para criar a nova tabela virtual, a partir do resultado da Query, selecionar 

 [v] Load as New Layer, e configurar como segue: 

 [v] Column with unique values: DISTRITO 

 [  ] Geometry column – sem geometria 

 Layer name (prefix): Hospitais_Privados 

 [ Execute ] 

 [ Load ] 

Há 78 distritos com hospitais privados (lembrando que esses dados são fictícios). 

(19) 

Carregar os dados de agregação dos hospitais privados no GeoPackage. Após terem sido 

verificados, eliminar a tabela virtual e salvar o projeto. 

(20) 

Agregar os dados dos Hospitais Públicos por distrito 

Com a query anterior ainda aberta na caixa de diálogo DB Manager 

 Senão, carregue a query salva anteriormente da sua pasta de trabalho 

  [ Load File ]. 

Edite manualmente o termo WHERE "HOSPITALS"."PUBLICO" = 'N' para WHERE 

"HOSPITALS"."PUBLICO" = 'S' 

Também substituir o prefixo Priv_ por Publ_ no campo Columns 

"HOSPITALS"."DISTRITO", 

Count(*) as Publ_Unidades, 

sum("HOSPITALS"."NUM_LEITOS") as Publ_Leitos, 

sum("HOSPITALS"."NUM_ENFERM") as Publ_Enferms, 

sum("HOSPITALS"."NUM_MEDICO") as Publ_Medicos, 

sum("HOSPITALS"."NUM_AMBULA") as Publ_Ambulas 



Salvar na pasta de trabalho a query editada como q_agrega_hospitais_publicos 

SELECT Count(*) as Publ_Unidades, 

"Hospitals"."DISTRITO", 

sum("Hospitals"."NUM_LEITOS") as Publ_Leitos, 

sum("Hospitals"."NUM_ENFERM") as Publ_Enferms, 

sum("Hospitals"."NUM_MEDICO") as Publ_Medicos, 

sum("Hospitals"."NUM_AMBULA") as Publ_Ambulas 

FROM "Hospitals" 

WHERE "Hospitals"."PUBLICO" = 'S' 

GROUP BY "Hospitals"."DISTRITO" 

ORDER BY "Hospitals"."DISTRITO" 

Para criar a novo layer, a partir do resultado da Query, selecionar 

[v] Load as New Layer, e configurar como segue: 

[v] Column with unique values: DISTRITO 

[  ] Geometry column 

Layer name (prefix): Hospitais_Publicos 

 [ Execute ] 

 [ Load ] 

A query está armazenada no GeoPackage e seu resultado é visível na lista de layers do 

QGis 

Há 46 distritos com hospitais públicos (lembrando, novamente, dos dados serem 

fictícios) 

(21) 

Carregar a tabela no Geopackage, e, após a verificação da qual, remover a tabela 

virtual e salvar o projeto. 

(22) 

Ambas tabelas podem ser cruzadas, seja pela operação Join tradicional, seja pela 

criação de novas camadas agregando essas informações. 

(23) 

Outros exemplos do uso do SQL Query Builder no DB Manager do QGis 

(1) quais os distritos sem hospitais em seus territórios? 

SELECT “distritosCEM-MSP”.”NOMECAPS” 

FROM “distritosCEM-MSP” left join “Hospitals” on 

“distritosCEM-MSP”.”NOMECAPS” = “Hospitals”.”DISTRITO” 

WHERE “Hospitals”.”DISTRITO” IS NULL 

 Evitar copiar este texto para o SQL Windows, mas, se o fizer, redigitar as aspas duplas, 

caso contrário resulta em erro de execução. 



 Resultado: 

NOMECAPS 

CURSINO 

BRASILANDIA 

ARICANDUVA 

MANDAQUI 

(2) encontrar o retângulo mínimo envolvente de cada distrito 

SELECT “distritosCEM-MSP”.”NOMECAPS”, 

ST_MinX(“distritosCEM-MSP”.”geom”) as Min_X, 

ST_MinY(“distritosCEM-MSP”.”geom”) as Min_Y, 

ST_MaxX(“distritosCEM-MSP”.”geom”) as Max_X, 

ST_MaxY(“distritosCEM-MSP”.”geom”) as Max_Y 

FROM “distritosCEM-MSP” 

Resultado (parcial): 

NOMECAPS Min_X Min_Y Max_X Max_Y 

CAMPO LIMPO 317136.42984838085 7382615.1244637 322358.44564271346 7387994.589195763 

VILA SONIA 320341.1143994743 7387072.492127307 324500.0968662841 7390960.603402897 

RAPOSO TAVARES 315348.06750900275 7387870.143354491 321060.25646242464 7391792.136802334 

RIO PEQUENO 318129.39694882673 7390457.834142642 322902.47824648686 7394397.353209858 

JAGUARE 320242.70828957873 7393570.338557038 323214.7845436528 7397261.230956792 

VILA LEOPOLDINA 321189.10845050286 7395008.19583369 324498.2153854292 7398443.618546369 

 

Obs: o SQL Query Builder lista cerca de 120 funções, inclusive espaciais, mas há 

questões levantadas em fóruns quanto ao funcionamento de diversas delas, 

em especial quando do uso em bancos de dados GeoPackage 

 


